## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome to ALOHA</td>
<td>1</td>
</tr>
<tr>
<td>About ALOHA</td>
<td>1</td>
</tr>
<tr>
<td>Program purpose</td>
<td>1</td>
</tr>
<tr>
<td>Basic program organization</td>
<td>1</td>
</tr>
<tr>
<td>ALOHA’s menu bar</td>
<td>2</td>
</tr>
<tr>
<td>Getting help</td>
<td>3</td>
</tr>
<tr>
<td>In Windows</td>
<td>5</td>
</tr>
<tr>
<td>On a Macintosh</td>
<td>5</td>
</tr>
<tr>
<td>How to use this manual</td>
<td>5</td>
</tr>
<tr>
<td>Introduction to air modeling</td>
<td>6</td>
</tr>
<tr>
<td>Dispersion modeling</td>
<td>6</td>
</tr>
<tr>
<td>What is dispersion?</td>
<td>7</td>
</tr>
<tr>
<td>The Gaussian equation</td>
<td>7</td>
</tr>
<tr>
<td>Heavy gases</td>
<td>8</td>
</tr>
<tr>
<td>Classification of heavy gases</td>
<td>9</td>
</tr>
<tr>
<td>Flash-boiling and two-phase flow</td>
<td>9</td>
</tr>
<tr>
<td>ALOHA’s heavy gas calculations</td>
<td>9</td>
</tr>
<tr>
<td>ALOHA can choose a dispersion model for you</td>
<td>10</td>
</tr>
<tr>
<td>ALOHA’s limitations</td>
<td>10</td>
</tr>
<tr>
<td>Very low wind speeds</td>
<td>11</td>
</tr>
<tr>
<td>Very stable atmospheric conditions</td>
<td>11</td>
</tr>
<tr>
<td>Wind shifts and terrain steering effects</td>
<td>12</td>
</tr>
<tr>
<td>Concentration patchiness</td>
<td>13</td>
</tr>
<tr>
<td>ALOHA does not account for the effects of...</td>
<td>14</td>
</tr>
<tr>
<td>...fires or chemical reactions</td>
<td>14</td>
</tr>
<tr>
<td>...particulates</td>
<td>15</td>
</tr>
<tr>
<td>...chemical mixtures</td>
<td>15</td>
</tr>
<tr>
<td>...terrain</td>
<td>15</td>
</tr>
<tr>
<td>Installing ALOHA</td>
<td>17</td>
</tr>
<tr>
<td>Before you install ALOHA</td>
<td>17</td>
</tr>
<tr>
<td>Memory and hard disk space requirements</td>
<td>17</td>
</tr>
<tr>
<td>In Windows</td>
<td>17</td>
</tr>
<tr>
<td>On a Macintosh</td>
<td>17</td>
</tr>
<tr>
<td>If you already have a previous version of ALOHA (5.2.3 or older)</td>
<td>17</td>
</tr>
<tr>
<td>If you already have a previous version of ALOHA 5.3</td>
<td>18</td>
</tr>
<tr>
<td>Installing ALOHA Windows</td>
<td>18</td>
</tr>
<tr>
<td>Making the installation</td>
<td>18</td>
</tr>
<tr>
<td>Your new Aloha menu will include</td>
<td>18</td>
</tr>
<tr>
<td>Installing ALOHA on a Macintosh</td>
<td>19</td>
</tr>
<tr>
<td>Making the installation</td>
<td>19</td>
</tr>
<tr>
<td>Learning the Basics</td>
<td>21</td>
</tr>
<tr>
<td>Guided tour</td>
<td>21</td>
</tr>
</tbody>
</table>
Chapter 1: Welcome to ALOHA

Describing the Time and Place ................................................................. 22
Choosing a Chemical .................................................................................. 24
Describing the Weather .............................................................................. 25
Describing the Release ............................................................................... 27
Checking the Computational Setting ......................................................... 32
Plotting a Footprint .................................................................................... 32
Checking Concentrations at a Location of Concern ..................................... 36
Exiting ( Quitting) ALOHA ........................................................................ 39

Reference ..................................................................................................... 41
The File and Edit menus ............................................................................... 41
The File Menu ............................................................................................. 41
  New ........................................................................................................... 41
  Open ......................................................................................................... 41
    Response Mode .................................................................................... 41
    Planning Mode .................................................................................... 42
  Close ......................................................................................................... 42
  Save and Save As .................................................................................. 42
  Print ........................................................................................................ 42
  Print All .................................................................................................. 43
  Quit or Exit ............................................................................................ 43
The Edit Menu ............................................................................................ 43
  Copy ........................................................................................................ 43
The SiteData Menu ..................................................................................... 43
  Location ................................................................................................. 44
    Selecting a location ............................................................................. 44
    Adding, modifying, and deleting location information ..................... 45
    Adding information about a U.S. city ................................................. 45
    Adding a location outside the U.S. ..................................................... 47
    Modifying a location ......................................................................... 48
    Deleting a location .......................................................................... 48
  Building Type ......................................................................................... 49
  Date & Time ........................................................................................... 51
The SetUp Menu .......................................................................................... 52
  Chemical ............................................................................................... 53
    Selecting a Chemical ......................................................................... 54
    Reactive chemicals .......................................................................... 54
    Chemical information in the Text Summary window ...................... 56
    Chemical Data .................................................................................... 57
    Adding, modifying, or deleting chemicals ....................................... 59
    How to add a chemical to the library .............................................. 59
    How to modify information about a chemical .............................. 60
    How to delete a chemical ................................................................ 61
  Atmospheric ........................................................................................... 61
    User Input ........................................................................................... 61
    Wind speed, direction, and measurement height ............................. 62
    Ground roughness ............................................................................. 65
Monitoring a long-term release ...................................................79
Source ..................................................................................80
ALOHA’s duration limits .........................................................80
ALOHA reports release rate .....................................................81
When you’re using a SAM ......................................................81
Direct source .........................................................................82
Describing a direct release ......................................................82
Source height .........................................................................83
Puddle ...................................................................................83
Entering information about a puddle .......................................85
Watch for changing weather conditions .................................87
Tank .....................................................................................87
Pressurized liquids ..................................................................88
Tank size and orientation .......................................................89
Chemical state .......................................................................89
Liquid in a tank .....................................................................91
Gas in a tank .........................................................................92
Chemical of unknown state in a tank .......................................93
Area and type of leak .............................................................93
Leak height on the tank wall ...................................................94
Puddle formation .....................................................................95
Pipe .....................................................................................96
Pipe source inputs ...................................................................97
Source strength information in the Text Summary ...................98
Computational .......................................................................99
Dispersion options ..................................................................99
Define dose ..........................................................................100
The Display Menu .................................................................101
Examples

Example 1: A Tank Source ................................................................. 119
  Choosing a location and a chemical ........................................... 119
  Entering weather information .................................................... 122
  Describing the release ................................................................. 125
  Choosing a LOC and plotting a footprint .................................... 130

Example 2: Direct Input (Heavy Gas) .................................................. 135
  Choosing a location, building type, and chemical ......................... 135
  Entering weather information .................................................... 138
  Describing the release ................................................................. 140
  Checking concentration .............................................................. 142

Example 3: A Pipe Source ................................................................. 147
  Choosing a location and a chemical ........................................... 147
  Entering weather information .................................................... 149
  Describing the release ................................................................. 152
  Choosing a LOC and plotting a footprint .................................... 153

Example 4: Using ALOHA and a MARPLOT map ...................... 157
  Choosing a location and a chemical ........................................... 157
  Entering weather information .................................................... 160
Chapter 1

Welcome to ALOHA

Welcome to ALOHA! This chapter contains an overview of ALOHA, an explanation of how to use this manual and ALOHA’s online help, and a discussion of basic air dispersion modeling concepts.

About ALOHA

Program purpose
ALOHA (Areal Locations of Hazardous Atmospheres) is a computer program designed especially for use by people responding to chemical accidents, as well as for emergency planning and training. ALOHA can predict the rates at which chemical vapors may escape into the atmosphere from broken gas pipes, leaking tanks, and evaporating puddles. It can then predict how a hazardous gas cloud might disperse in the atmosphere after an accidental chemical release.

ALOHA runs quickly on small computers (Windows or Macintosh) that are easily transportable and affordable for most people. It is designed to be easy to use so that you can operate it successfully during high-pressure situations. Its chemical library contains information about the physical properties of about 1,000 common hazardous chemicals. Its computations represent a compromise between accuracy and speed: it has been designed to produce good results quickly enough to be of use to responders. ALOHA is designed to minimize operator error. It checks information that you enter and warns you when you make a mistake. ALOHA’s online help offers you quick access to explanations of ALOHA’s features and computations, as well as background information to help you interpret its output.

Basic program organization
To use ALOHA, you’ll typically perform several basic steps:

- indicate the city where an accidental chemical release is occurring and the time and date of the accident,
- choose the chemical of concern from ALOHA’s library of chemical information,
- enter information about current weather conditions,
Chapter 1: Welcome to ALOHA

- describe how the chemical is escaping from containment,
- request ALOHA to display a footprint, showing the area where chemical concentrations in the air may become high enough to pose a hazard to people (ALOHA can display this footprint on an electronic map of your city).

You can also view graphs showing predicted indoor and outdoor chemical concentrations at any location of special concern downwind of a release (such as a school or hospital), and the dose of chemical to which people at that location may be exposed. You can save ALOHA results as archive files, and you can copy and paste graphs, plots, and text information from ALOHA into documents or reports in word-processing or graphics programs.

ALOHA’s menu bar

Perform basic ALOHA operations by moving left-to-right through the six menus in its menu bar:

- **File and Edit:** Choose items from these two menus to perform basic Macintosh and Microsoft Windows™ operations, such as opening, closing, and saving files; printing the contents of ALOHA’s windows; and copying text and graphics displayed in ALOHA.

- **SiteData:** Choose items from the SiteData menu to enter information about (a) the date and time and (b) location of an accidental release, and (c) the type of buildings downwind of the release.

- **SetUp:** Choose items from the SetUp menu to (a) select a chemical from ALOHA’s chemical library (or to add a chemical to the library, if you need to), (b) indicate weather conditions (you can do this either manually or by connecting your computer to a portable meteorological station), (c) “set the source” (describe how the chemical is escaping from containment into the atmosphere), (d) choose the type of dispersion calculations for ALOHA to make (ALOHA can predict the movement of either “neutrally buoyant” clouds that are about as dense as air and “heavy gas” clouds, which are denser than air), and (e) adjust the exponent in ALOHA’s dose equation (dose is the accumulated amount of the chemical to which a person is exposed at a particular location).

- **Display:** Choose items from the Display menu to indicate the ALOHA results that you would like to see and to choose how you would like the information to be displayed. Choose to tile or stack ALOHA’s windows and choose whether to see
ALOHA’s results displayed in English or metric units. Select a **Level of Concern (LOC)** for the footprint (this is the threshold concentration of an airborne pollutant, usually the concentration above which a hazard may exist. ALOHA’s footprint represents the zone where the ground-level pollutant concentration may exceed your LOC at some time after a release begins). Choose to see the footprint either plotted on a grid (at a scale automatically selected by ALOHA) or displayed at a scale that you specify.

**Sharing:** Choose items from this menu (a) to display an ALOHA footprint on a background map using MARPLOT, the CAMEO mapping module, or (b) to see detailed information about the chemical you’ve selected, displayed in CAMEO’s Response Information Data Sheets (RIDS) module.

![ALOHA's menus on a Macintosh](image)

Figure 1-1. ALOHA’s menus on a Macintosh (ALOHA’s menus in Windows are nearly identical).

**Getting help**

Online help is available at any time when ALOHA is running. If you’re running ALOHA, the right-most menu is the Help menu. Select Topics… from the Help menu and a Help Index will appear.

![Help](image)

Figure 1-2. Accessing ALOHA Help.

In Windows or on a Macintosh, click **Help** buttons on ALOHA windows and dialog boxes (Figure 1-4) to view information about particular features or required model inputs.
Chapter 1: Welcome to ALOHA

Figure 1-4. Clicking an ALOHA Help button on a Macintosh.

In Windows or on a Macintosh, the Help Index that you access from About ALOHA is arranged alphabetically (Figure 1-5).

Figure 1-5. ALOHA Help Index on a Macintosh.
Chapter 1: Welcome to ALOHA

In Windows; Click any topic name to view a discussion of that topic. When you’ve finished reading about that topic, click Contents to return to the Help Index. When you are ready to go back to using ALOHA, close or minimize the Help window.

On a Macintosh Highlight a topic name, then click Select to view a discussion of that topic. When you’ve finished reading the topic discussion, click either Topics or Cancel to return to the Help index to select another topic, Print to print the Help screen, or Copy to copy the discussion text to the clipboard.

ALOHA'S LIMITATIONS

ALOHA cannot be more accurate than the information you give it to work with. Even when you provide the best input values possible, ALOHA, like any model, can be unreliable in certain situations, and it cannot model some types of releases at all.

ALOHA's results can be unreliable when the following conditions exist:

(e) Very low wind speeds - ALOHA's footprint accurately depicts a pollutant cloud's location only if the wind direction does not change from the value that you entered. Generally, wind direction is least predictable when wind speed is low. To show how much the cloud's position could change if the wind were to shift direction, under the particular weather conditions that you enter, ALOHA draws two dashed lines, one along each side of the footprint. ALOHA predicts that about 95 percent of the time, the wind will

Figure 1-6. Sample Help text on a Macintosh.

How to use this manual

This manual includes six chapters. Begin here in Chapter 1 by reviewing a discussion of basic air modeling concepts. Turn to Chapter 2 for instructions on installing ALOHA, and to Chapter 3 for a step-by-step ALOHA tutorial. Chapter 4 contains descriptions of the main features of ALOHA. Sections in this chapter include explanations of each of ALOHA’s menus, along with background information to help you to better understand ALOHA’s computations. Turn to Chapter 5 for some ALOHA example problems, and to Chapter 6 for trouble-shooting advice. At the back of the manual, you’ll find a bibliography, a glossary of air modeling terms, and an index.
Introduction to air modeling

ALOHA is an air dispersion model, which you can use as a tool for predicting the movement and dispersion of gases. It predicts pollutant concentrations downwind from the source of a spill, taking into consideration the physical characteristics of the spilled material. ALOHA also accounts for some of the physical characteristics of the release site, weather conditions, and the circumstances of the release. Like many computer programs, it can solve problems rapidly and provide results in a graphic, easy-to-use format. This can be helpful during an emergency response or planning for such a response. Keep in mind that ALOHA is only a tool. Its usefulness depends on your accurate interpretation of the data.

ALOHA originated as a tool to aid in emergency response. It has evolved over the years into a tool used for a wide range of response, planning, and academic purposes. However, you must still rely on your own common sense and experience when deciding how to respond to a particular incident. There are some features that would be useful in a dispersion model (for example, equations accounting for site topography) that have not been included in ALOHA because they would require extensive input and computational time. ALOHA’s most important limitations are discussed in the following pages.

Dispersion modeling

Many different types of air dispersion models exist. They range from simple equations that can be solved by hand to complex models that require massive amounts of input data and powerful computers. The type of model appropriate for a particular use depends on the scale of the problem, the level of detail available for input and required for output, the background of the intended user, and the time available to wait for the model computations to be completed.

ALOHA was designed with first responders in mind. It is intended to be used for predicting the extent of the area downwind of a short-duration chemical accident where people may be at risk of exposure to hazardous concentrations of a toxic gas. It is not intended for use with accidents involving radioactive chemicals. Nor is ALOHA intended to be used for permitting of stack gas or modeling chronic, low-level (“fugitive”) emissions. Other models are designed to address larger scale and/or air quality issues (Turner and Bender 1986). Since most first responders do not have dispersion modeling backgrounds, ALOHA has been designed to require input data that are either easily obtained or estimated at the scene of an accident. ALOHA’s online help can assist you in choosing inputs.
What is dispersion?

Dispersion is a term used by modelers to include advection (moving) and diffusion (spreading). A dispersing vapor cloud will generally move (advect) in a downwind direction and spread (diffuse) in a crosswind and vertical direction (crosswind is the direction perpendicular to the wind). A cloud of gas that is denser or heavier than air (called a heavy gas) can also spread upwind to a small extent.

ALOHA models the dispersion of a cloud of pollutant gas in the atmosphere and displays a diagram that shows an overhead view of the area in which it predicts that gas concentrations will reach hazardous levels. This diagram is called the cloud’s footprint. To obtain a footprint plot, you first must identify a threshold concentration of an airborne pollutant, usually the concentration above which the gas may pose a hazard to people. This value is called the Level of Concern. The footprint represents the area within which the ground-level concentration of a pollutant gas is predicted to exceed your Level of Concern (LOC) at some time after a release begins.

There are really two separate dispersion models in ALOHA: Gaussian and heavy gas.

ALOHA uses the Gaussian model to predict how gases that are about as buoyant as air will disperse in the atmosphere. Such neutrally buoyant gases have about the same density as air. According to this model, wind and atmospheric turbulence are the forces that move the molecules of a released gas through the air, so as an escaped cloud is blown downwind, “turbulent mixing” causes it to spread out in the crosswind and upward directions. According to the Gaussian model, a graph of gas concentration within any crosswind slice of a moving pollutant cloud looks like a bell-shaped curve, high in the center (where concentration is highest) and lower on the sides (where concentration is lower). Right at the point of a release, the pollutant gas concentration is very high, and the gas has not diffused very far in the crosswind and upward directions, so a graph of concentration in a crosswind slice of the cloud close to the source looks like a spike. As the pollutant cloud drifts farther downwind, it spreads out and the “bell shape” becomes wider and flatter.
When a gas that is heavier than air is released, it initially behaves very differently from a neutrally buoyant gas. The heavy gas will first “slump,” or sink, because it is heavier than the surrounding air. As the gas cloud moves downwind, gravity makes it spread; this can cause some of the vapor to travel upwind of its release point. Farther downwind, as the cloud becomes more diluted and its density approaches that of air, it begins behaving like a neutrally buoyant gas. This takes place when the concentration of heavy gas in the surrounding air drops below about 1 percent. For many small releases, this will occur in the first few yards (meters). For large releases, this may happen much further downwind.
Chapter 1: Welcome to ALOHA

Figure 1-9. Cloud spread as a result of gravity.

A gas that has a molecular weight greater than that of air (the average molecular weight of air is about 29 kilograms per kilomole) will form a heavy gas cloud if enough is released. Gases such as anhydrous ammonia that are lighter than air at room temperature, but that are stored in a cryogenic (low-temperature) state, can also form heavy gas clouds. If the density of a gas cloud is substantially greater than the density of the air (the density of air is about 1.1 kilograms per cubic meter), ALOHA considers the gas to be heavy.

Many substances that are gases under normal pressures and temperatures are stored under high enough pressures to liquefy them. For example, propane is a gas at normal pressures and temperatures but is often stored under pressure as a liquid. When a tank rupture or broken valve causes a sudden pressure loss in a tank of liquefied gas, the liquid boils violently, the tank contents foam up, and the tank fills with a mixture of gas and fine liquid droplets (called aerosol). Flash-boiling is the sudden vaporization of a liquid caused by a loss of pressure. When the liquid and gas phases of a chemical escape together from a ruptured tank, the release is called a two-phase flow. When such a two-phase mixture escapes from storage, the release rate can be significantly greater than that for a release of pure gas. When liquefied propane or a similar chemical escapes from storage as a two-phase release, it can form a heavy gas cloud. The cloud is heavy in part because it is initially cold, and therefore dense, and also because it consists of a two-phase mixture. The tiny aerosol droplets mixed into the cloud act to weigh the cloud down and make it more dense, and their evaporation acts to cool the cloud.

The heavy gas dispersion calculations that are used in ALOHA are based on those used in the DEGADIS model (Spicer and Havens 1989), one of several well-known heavy gas models. This model was selected because of its general acceptance and the extensive testing that was carried out by its authors. In order to speed up the computational procedures and reduce the requirement for input data that would typically be difficult to
obtain during an accidental release, a few simplifications were introduced into ALOHA-DEGADIS, making it different from the DEGADIS model. These simplifications include:

- ALOHA does not use elevated sources to account for the initial momentum of a jet release. ALOHA-DEGADIS assumes that all heavy gas releases originate at ground level;
- the mathematical approximation procedures used for solving the model’s equations are faster, but less accurate than those used in DEGADIS; and
- ALOHA-DEGADIS models sources for which the release rate changes over time as a series of short, steady releases rather than as a number of individual point source puffs.

Throughout the creation of ALOHA-DEGADIS, NOAA worked closely with the original authors of DEGADIS to ensure a faithful representation of DEGADIS model dynamics. ALOHA-DEGADIS was checked against DEGADIS to ensure that only minor differences existed in results obtained from both models. Considering the typical inaccuracies common in emergency response, these differences are probably not significant. In cases where technical accuracy is required, you should obtain the original DEGADIS model and use it to investigate the scenarios of interest.

ALOHA can automatically choose whether to predict the dispersion of a chemical as a Gaussian or heavy gas release (it bases this choice mainly on molecular weight, size of the release, and temperature of the gas cloud). But sometimes you may want to specify the model to use rather than letting ALOHA choose. In particular, when a chemical with a molecular weight less than that of air has been stored at a low temperature or under high pressure, it can behave like a heavy gas (ammonia is an example of such a chemical). If you have chosen one of these chemicals, depending on how you model its release, ALOHA may not have enough information about the release to determine whether a heavy gas could be formed. In such a case, ALOHA will make Gaussian calculations, but will alert you that you should try running the heavy gas model as well. In such cases, you should re-run ALOHA using the heavy gas calculations, and compare the two footprint estimates.

**ALOHA’s limitations**

Like any model, ALOHA cannot be more accurate than the information you give it to work with. But even when you provide the best input values possible, ALOHA, like any
model, can be unreliable in certain situations, and it cannot model some types of releases at all.

Even when you can provide accurate input information, ALOHA’s results can be unreliable when the following conditions exist:

- very low wind speeds
- very stable atmospheric conditions
- wind shifts and terrain steering effects
- concentration patchiness, particularly near the spill source

ALOHA doesn’t account for the effects of:

- fires or chemical reactions
- particulates
- chemical mixtures
- terrain

ALOHA’s footprint accurately depicts a pollutant cloud’s location only if the wind direction does not change from the value that you entered. Generally, wind direction is least predictable when wind speed is low. To show how much the cloud’s position could change if the wind were to shift direction, under the particular weather conditions that you enter, ALOHA draws two dashed lines, one along each side of the footprint. ALOHA predicts that about 95 percent of the time, the wind will not shift direction enough to steadily blow the pollutant cloud outside of either line. The wider the zone between the lines, the less predictable is the wind direction and the more likely it is to change substantially. At the lowest wind speeds acceptable to ALOHA (about 2 knots, or 1 meter per second, at a height of 10 meters), these lines form a circle to indicate that the wind could blow from any direction.

Under the most stable atmospheric conditions (most common late at night or very early in the morning), there is usually very little wind and almost no mixing of the pollutant cloud with the surrounding air. Gas concentrations within the cloud can remain high far from the source. The accidental release of methyl isocyanate gas at Bhopal, India, in 1984 is an example of what can happen under
people died, including many who were far from the release. In a very stable atmosphere, a chemical cloud will spread out in the same manner as cream poured into a coffee cup. The cream will dilute and spread slowly into the coffee, but, until you stir it, will take a very long time to mix completely into the coffee. Similarly, the cloud will spread slowly, and high gas concentrations may build up in small valleys or depressions and remain for long periods of time, even at distances far from the release point. ALOHA does not account for buildup of high gas concentrations in low-lying areas.

First responders should be aware that very stable atmospheric conditions create a dangerous situation in which models like ALOHA are not very reliable. In this situation, think about whether the chemical will behave as a heavy gas, and look for physical depressions and topographic features that may trap or steer the dispersing cloud.

ALOHA allows you to enter only single values for wind speed and wind direction. It then assumes that wind speed and direction remain constant (at any given height) throughout the area downwind of a chemical release. ALOHA also expects the ground below a dispersing cloud to be flat and free of obstacles. In reality, though, the wind typically shifts speed and direction as it flows up or down slopes, between hills or down into valleys, turning where terrain features turn. The way in which land features modify patterns of air flow is called **terrain steering**.

Figure 1-10. Wind shifts.

In urban areas, wind flowing around large buildings forms eddies and changes direction and speed, significantly altering a cloud’s shape and movement. Through streets bordered
by large buildings can generate a “street canyon” wind pattern that constrains and funnels a dispersing cloud. ALOHA ignores these effects when it produces a footprint plot; the footprint will appear to go right over, or through, obstacles such as buildings. Consider the effects of terrain on wind flow whenever you are interpreting ALOHA results.

Figure 1-11. Small-scale variations in wind direction.

Because the wind is likely to shift in direction and change speed over both distance and time, limits have been placed on ALOHA’s output. ALOHA will not make predictions for more than an hour after a release begins, or for distances more than 10 kilometers (6.2 miles) from the release point (it truncates footprints that are longer than 10 kilometers). ALOHA’s 1-hour time cutoff exists because wind shifts direction and changes speed frequently. One reason for the 10-kilometer cutoff for ALOHA footprint length is that we don’t know what the wind speed and direction are 10 kilometers away, and can’t assume that they are the same as those we’re experiencing at the point where a pollutant is being released. If ALOHA has incorrect values for wind speed and direction, it can’t correctly estimate footprint size or location.

No one can predict gas concentrations at any particular instant downwind of a release with certainty, because they result partly from random chance. Instead, ALOHA shows you concentrations that represent averages for time periods of several minutes (it uses the laws of probability as well as meteorologists’ knowledge of the atmosphere to do this). ALOHA predicts that average concentrations will be highest near the release point and along the centerline of any pollutant cloud, and will drop off smoothly and gradually in the downwind and crosswind directions. However, especially near the source of a release,
wind eddies push a cloud unpredictably about, causing gas concentrations at any moment to be high in one location and low in another. This kind of movement is familiar to anyone who has tried to toast marshmallows over a campfire (no matter where you sit, the smoke from the fire always seems to come straight towards you). Meanwhile, the average concentrations are likely to behave approximately as ALOHA predicts. As the cloud moves downwind from the release point, these eddies shift and spread the cloud, evening out concentrations within the cloud so that they become more similar to ALOHA’s predictions.

Figure 1-12. Concentration patchiness close to the source.

**ALOHA does not account for the effects of...**

The smoke from a fire, because it has been heated, rises rapidly before it begins to move downwind. ALOHA doesn’t account for this initial rise. It also doesn’t account for the by-products of combustion, or for chemical reactions of any kind. ALOHA assumes that a dispersing chemical cloud does not react with the gases that make up the atmosphere, such as oxygen and water vapor. However, many chemicals react with dry or humid air, water, other chemicals, or even themselves. Because of these chemical reactions, the chemical that disperses downwind might be very different from the chemical that originally escaped from containment. In some cases, this difference may be substantial enough to make ALOHA’s dispersion predictions inaccurate. For example, if aluminum phosphide escapes from containment and comes in contact with water, the reaction between the water and aluminum phosphide produces phosphine gas. It is the phosphine,
rather than the aluminum phosphide, that escapes into the atmosphere. If you respond to such an accident, and wish to use ALOHA to obtain a footprint estimate, you need to estimate how rapidly phosphine is being generated from the reaction between water and aluminum phosphide, and you need to model the incident in ALOHA as a release of phosphine, rather than aluminum phosphide.

ALOHA does not account for the processes that affect dispersion of particulates (including radioactive particles).

ALOHA is designed to model the release and dispersion of pure chemicals and some chemical solutions. It’s difficult for any model to correctly predict the behavior of a solution or a mixture of chemicals because it’s difficult to accurately predict chemical properties such as vapor pressure for solutions or mixtures. ALOHA’s predictions are greatly affected by this and other chemical properties. When an incorrect property value is used in ALOHA, the model’s release rate and dispersion estimates will not be valid.

ALOHA expects the ground below a leaking tank or puddle to be flat, so that the liquid spreads out evenly in all directions. It does not account for pooling within depressions or the flow of liquid across sloping ground.